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Chapter 1 

Fundamental of Antenna 

 

1.1 Introduction  

 

1.1.1 What is an Antenna? 

An antenna is a device (usually metallic) for sending or receiving electromagnetic waves. The 

antenna is an important part of radio equipment. The antenna has to be tuned to the right 

frequency or the radio waves can neither be emitted nor captured efficiently. In transmission, a 

radio transmitter applies a radio frequency to the terminals of the antenna and then the antenna 

radiates the energy from the antenna as electromagnetic waves. In reception, an antenna 

intercepts some of the power of an electromagnetic wave to produce a radio frequency at its 

terminals that is applied to a receiver in order to be amplified and demodulated. In some cases 

the same antenna can be used for both transmitting and receiving. 

 

 

1.2 Types of Antennas 

There are several different kinds of antennas available at Future Electronics. We stock many of 

the most common types categorized by several parameters including operating frequency, power 

handling, gain, operating temperature range and type. These types include rubber ducky, 

embedded, conformal and weatherized. 
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1.3 Antenna parameters  

The major parameters of an antenna are defined in the following subsection.  

 

 

 

 

1.3.1 Antenna Gain 

Antenna gain is defined as the radio between the radiation intensity in a given particular 

direction and total input power. The radiation intensity Unexpressed the power radiated per solid 

angle. IN terms of U the Antenna gain in a specified direction can be calculated.  

 

G= 
𝑈

𝑃𝑖𝑛/4𝜋
 

 

1.3.2 Antenna Efficiency 

Antenna efficiency is defined by IEEE Std 145-1993 “Standard Definition of Terms for 

Antennas “as “The ratio of the total power radiated by an antenna to the net power accepted by 

the antenna from the connected transmitter”. It is sometimes expressed as percentage (less than 

100), and it is frequency dependent.  

 

1.3.3 Antenna Effective Area 

In electromagnetic and antenna theory. Antenna aperture of effective area is a measure of how 

effective an antenna is at receiving the power of radio waves. The aperture is defined as the area, 

oriented perpendicular to the direction of an incoming wave, which, would intercept the same 

amount of power from that waves as is produced by the antenna receiving it. At any point, a 
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beam of radio waves has an irradiance or power flux density (PFD) which is the amount of radio 

power passing through a unit area.  

 

 

1.3.4 Directivity 

In electromagnetics, directivity is a figure of merit for an antenna. It measures the power density 

the antenna radiates in the direction of its strongest emission, versus the power density radiated 

by an ideal isotropic radiator (which emits uniformly in all directions) radiating the same total 

power. 

 

An antenna's directivity is a component of its gain; the other component is its 

(electrical) efficiency. Directivity is an important measure because most emissions are intended 

to go in a particular direction or at least in a particular plane (horizontal or vertical); emissions in 

other directions or planes are wasteful (or worse). 

 

1.3.5 Bandwidth 

The properties of input impedance, polarization gain of an antenna do not necessary vary in the 

same manner, moreover there is no distinctive character of the bandwidth to calculate percentage 

of bandwidth: % of BW = (f2-f1)/f0*100% 

 

1.3.6 Radiation Pattern 

A radiation pattern defined as the variation of the power radiation from an antenna which is away 

from the antenna. The radiation pattern is a plot of the fare –field radiation properties of an 

antenna. The spatial coordinates which are specified by the elevation angle (ф) and the azimuth 

angle (Ѳ). It is a plot of the power radiated from an antenna per unit solid angle which is nothing 

but the radiation intensity. It can plotted as a 3D graph. It is an extremely important parameter as 

is show the antenna directivity as well as gain at various points in space.  

 

 

 

https://en.wikipedia.org/wiki/Electromagnetism
https://en.wikipedia.org/wiki/Figure_of_merit
https://en.wikipedia.org/wiki/Antenna_(radio)
https://en.wikipedia.org/wiki/Isotropic_radiator
https://en.wikipedia.org/wiki/Antenna_gain
https://en.wikipedia.org/wiki/Antenna_efficiency
https://en.wikipedia.org/wiki/Multipath_propagation
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1.3.7 Return Loss 

In telecommunications, return loss is the loss of power in the signal returned/reflected by a 

discontinuity in a transmission line or optical fiber. This discontinuity can be a mismatch with 

the terminating load or with a device inserted in the line. It is usually expressed as a ratio 

in decibels (dB); 

 

Where RL (dB) is the return loss in dB, Pi is the incident power and Pr is the reflected power. 

Return loss is related to both standing wave ratio (SWR) and reflection coefficient (Γ). 

Increasing return loss corresponds to lower SWR. Return loss is a measure of how well devices 

or lines are matched. A match is good if the return loss is high. A high return loss is desirable 

and results in a lower insertion loss. 

 

1.3.8 Beam Width 

 

In an antenna pattern the half power beam width is the angle between the half power (-3dB) 

points of the main lobe, when referenced to the peak effective radiated power of the main lobe. A 

typical polar diagram showing beam width is as show below.  

 

1.3.9 Input Impedance 

The input impedance of an electrical network is the impedance from the source into the network 

being connected. In other words, the input impedance is the impedance, if placed across the input 

terminals that would produce the same voltage across and current through the input terminals as 

the electrical network being connected. Therefore, the input impedance of the network being 

connected and the output impedance of the source determines the transfer function from the 

source to the input terminals of the circuit. 

 

 

https://en.wikipedia.org/wiki/Telecommunications
https://en.wikipedia.org/wiki/Power_(physics)
https://en.wikipedia.org/wiki/Signalling_(telecommunication)
https://en.wikipedia.org/wiki/Transmission_line
https://en.wikipedia.org/wiki/Optical_fiber
https://en.wikipedia.org/wiki/Decibel
https://en.wikipedia.org/wiki/Standing_wave_ratio
https://en.wikipedia.org/wiki/Reflection_coefficient
https://en.wikipedia.org/wiki/Insertion_loss
https://en.wikipedia.org/wiki/Electrical_impedance
https://en.wikipedia.org/wiki/Electrical_network
https://en.wikipedia.org/wiki/Electrical_impedance
https://en.wikipedia.org/wiki/Transfer_function
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1.3.10 Voltage Standing Wave Ratio (VSWR) 

For a radio (transmitter or receiver) to deliver power to an antenna, the impedance of the radio 

and transmission line must be well matched to the antenna's impedance. The parameter VSWR is 

a measure that numerically describes how well the antenna is impedance matched to the radio or 

transmission line it is connected to. 

 

1.4 UWB: 

The word ‘ultra-wideband’ (UWB) commonly refers to signals or systems that either have a 

large relative, or a large absolute bandwidth. Such a large bandwidth offers specific advantages 

with respect to signal robustness, information content and/or implementation simplicity, but lead 

to fundamental differences from conventional, narrowband systems. 

 

The bandwidth and VSWR level with band notch characteristics are optimized with slot length 5 

mm, slot width 9.4 mm and slot thickness 1.25 mm, whereas other parameters are same as it is 

and the antenna is still working within UWB range. The input impedance of the presented 

antenna is given in the smith chart of Fig. 2. The resonant loops of the antenna are to be found 

close to the center of the smith chart, showing better matching to the input impedance. Few 

resonant frequencies are being stimulated. The small loop on the smith chart does not indicate 

true resonant frequencies as not crossing the real axis but the wideband impedance characteristic 

is visible from the impedance curve. It is important to mention that these intimately spaced 

multiple resonances which are harmonics of fundamental resonance overlap, resulting in ultra 

wide bandwidth. The simulated VSWR of the antenna with and without the band notch is 

depicted in Fig.3. It is observed in the result that the antenna has a wide bandwidth ranging from 

3.4 GHz to 10.6 GHz with a band notch characteristics across 5 GHz to 6 GHz. This band notch 

characteristic is required to reduce the interference from WLAN systems. 

 

 
 

                      Figure 1.1:  Input Impedance chart with notch (red) and without notch (green) 

http://www.antenna-theory.com/
http://www.antenna-theory.com/basics/impedance.php
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           Figure1.2: Radiation pattern for proposed antenna at 3.8 GHz 

 

 

 

 

1.5 What is Array Antenna? 

An antenna array (often called a 'phased array') is a set of 2 or more antennas. The signals from 

the antennas are combined or processed in order to achieve improved performance over that of a 

single antenna.  

 

An antenna array is a set of individual antennas used for transmitting and/or receiving radio 

waves, connected together in such a way that their individual currents are in a specified 

amplitude and phase relationship. This allows the array to act as a single antenna, generally with 

improved directional characteristics (thus higher antenna gain) than would be obtained from the 

individual elements. The resulting array in fact is often referred to and treated as "an antenna," 

particularly when the elements are in rigid arrangement with respect to each other, and when the 

ratio of currents (and their phase relationships) are fixed. On the other hand, a steerable 

array may be fixed physically but has electronic control over the relationship between those 

currents, allowing for adjustment of the antenna's directionality without requiring physical 

motion. 

https://en.wikipedia.org/wiki/Radio_wave
https://en.wikipedia.org/wiki/Radio_wave
https://en.wikipedia.org/wiki/Antenna_gain
https://en.wikipedia.org/wiki/Phased_array
https://en.wikipedia.org/wiki/Phased_array
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The array uses electromagnetic wave interference to enhance the radiative signal in one desired 

direction at the expense of other directions. It may also be used to null the radiation pattern in 

one particular direction, especially for a receiving antenna in the face of a particular interfering 

source. 

 

 

 

 

 

 1.6 Advantages and Disadvantages of Microstrip Patch Array antenna: 

1.6.1 ADVANTAGES: 

• Ease of manufacturing  

• It has a low fabrication cost 

• Microstrip patch antennas are efficient radiators 

• It has a support for both linear and circular polarization 

• Easy in integration with microwave integration circuits 

• Unlike linear arrays, distortions in the array pattern of a circular array due to 

mutual coupling effect are same for each element and this makes it easier to deal 

with the mutual coupling effects. 

• Capable of dual and triple frequency operations. 

•  High performance 

• Supports both, linear as well as circular polarization.  

 

 

 

 

1.7 APPLICATIONS OF MICROSTRIP PATCH ARRAY ANTENNA: 

 

Microstrip antennas possess attractive features such as low profile, light weight, small 

volume and low production cost. In addition, integrating the microstrip feed structure with 

the radiating elements on the same substrate attains the benefit of a compact low cost feed 
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network. However, losses in the microstrip feed network form a significant limit on the 

possible applications of microstrip antenna arrays in mm wave frequency range. However, in 

some applications the radiators in the array are not connected by an array feed network. In 

these applications we may benefit from the advantages of microstrip antennas. In this paper 

we describe the development and applications of mm wave microstrip arrays. MM wave 

microstrip antenna arrays may be employed in communication links, seekers and detection 

arrays. The arrays consists around 256 elements to 1024 elements. Design considerations of 

the antenna and the feed network are given in this paper. Optimization of the antenna and 

feed network allows us to design microstrip antenna arrays with high efficiency. 

 

 

 

 

 

 

 

 

 

 

 

 

1.8Why Micro strip Patch Antennas is been used? 

 

 

An antenna array (often called a 'phased array') is a set of 2 or more antennas. The signals 

from the antennas are combined or processed in order to achieve improved performance over 

that of a single antenna. The antenna array can be used to: 

 

 

• increase the overall gain 

• provide diversity reception 

• cancel out interference from a particular set of directions 

• "steer" the array so that it is most sensitive in a particular direction 

• determine the direction of arrival of the incoming signals 

• to maximize the Signal to Interference Plus Noise Ratio (SINR) 
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Chapter 2 
Architecture of Patch Antenna 

 
 

 
2.1 Basic Architecture  

 

Microstrip patch antenna is vastly used where size, weight, cost, performance and simplicity 

of installation are constraints. 

 

 

 
 
 
 

The basic configuration is a metallic patch etched on to an electrically thin and grounded 

dielectric substrate, as shown in Figure 2. The thickness of the substrate is much less than. In 

general, the patch element is fed asymmetrically by an unbalanced feed. The main 

dimensions of patches are of the order of where is an equivalent operating wavelength 
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2.2 Some basic characteristics: 
 

 
 
 
 
 

• The patch should be a very thin metallic strip (t<<free space wavelength) 

• dielectric constants are usually in the range of  

• For good antenna performance, a thick dielectric substrate having a low dielectric 

constant is desirable since this provides better efficiency, larger bandwidth and better 

radiation. 

• But this configuration leads to a larger antenna size. 

• Higher dielectric constants may be used which are less efficient result in narrower 

bandwidth. 

• In security system narrow bandwidth is expected. 
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2.3 Different shape of patch: 
 
 
 

 

                                                      
 
 
Square                                                      Rectangular                                      Circle  
 
 
 

 

                                    
 

Triangle                                                    Circular Ring 
 

 
 

 

                                                    
 
Dipole                                                                  Elliptical          
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2.4 Fundamental specifications for Patch Antenna: 
 

• Radiation Pattern 

• Polarization 

• Antenna Gain 

• Bandwidth 

• Directivity  

2.5 Feeding Technique 

 

There are many methods of feeding a micro strip antenna. The most popular methods are: 

1. Micro strip Line. 

2. Coaxial Probe (coplanar feed). 

3. Proximity Coupling. 

4. Aperture Coupling.  

 

2.6.1 Micros trio Line feed 

This method of feeding is very widely used because it is very simple to design and analyze, and 

very easy to manufacture. Previously, the patch antenna was fed at the end as shown here. Since 

this typically yields a high input impedance, we would like to modify the feed. Since the current 

is low at the ends of a half-wave patch and increases in magnitude toward the center, the input 

impedance (Z=V/I) could be reduced if the patch was fed closer to the center. One method of 

doing this is by using an inset feed (a distance R from the end) as shown in Figure 1. 
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                                            Figure 2.1. Patch Antenna with an Inset Feed. 

 

2.6.2 Coaxial Probe (coplanar feed): 

Micro strip antennas can also be fed from underneath via a probe as shown in Figure 3. The outer 

conductor of the coaxial cable is connected to the ground plane, and the center conductor is 

extended up to the patch antenna. The position of the feed can be altered as before (in the same 

way as the inset feed, above) to control the input impedance 

 

                                   Figure 2.2. Coaxial cable feed of patch antenna. 
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2.6.3 Aperture coupled Feed: 

 

 

 

 

                                       Figure 2.3: Aperture coupler feeding 
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2.7 Comparing the different feed techniques 

 

Characteristics Micro strip 

Line Feed 

Coaxial Feed Aperture 

Coupled 

Feed 

Proximity 

Coupled Feed 

Spurious feed 

Radiation 

More  More Less Minimum  

Reliability Better Poor due to 

Soldering 

Good Good 

Ease of Fabrication Easy  Soldering and 

drilling needed  

Alignment 

required  

Alignment 

required  

Impedance Matching Easy  Easy  Easy  Easy 

Bandwidth (achieved 

with impedance 

matching) 

2.5% 2.5% 2.5% 13% 

 

2.8 Methods of Analysis  

There are many methods of analysis for patch antenna, they are transmission line model, cavity 

model and full wave model. The transmission line model is the easiest of all, it gives good 

physical insight, but it is less accurate and it is more difficult to model coupling. Compared to 

the transmission line model, the cavity model is more accurate, but it is more complex. 
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                                                                          Chapter 3 

Methodology 

 

 

3.1 Introduction to HFSS 

HFSS is a commercial finite element method solver for electromagnetic structures from Ansys. 

The acronym originally stood for high frequency structural simulator. It is one of several 

commercial tools used for antenna design, and the design of complex RF electronic circuit 

elements including filters, transmission lines, and packaging. It was originally developed by 

Professor Zoltan Cendes and his students at Carnegie Mellon University. Prof. Cendes and his 

brother Nicholas Csendes founded Ansoft and sold HFSS stand-alone under a 1989 marketing 

relationship with Hewlett-Packard, and bundled into Ansoft products. [1] After various business 

relationships over the period 1996-2006, H-P (which became Agilent EEs of EDA division) and 

Ansoft went their separate ways: [2] Agilent with the critically acclaimed [3] FEM Element and 

Ansoft with their HFSS products, respectively. Ansoft was later acquired by Ansys. 

The Ansoft High Frequency Structure Simulator (HFSS) is a full-wave electromagnetic (EM) 

software package for calculating the electromagnetic behavior of a 3-D structure. 

Using HFSS, you can compute: 

Basic electromagnetic field quantities and, for open boundary problems, radiated near and far 

fields; The eigen modes, or resonances, of a structure; Port characteristic impedances and 

propagation constants; Generalized S-parameters and S-parameters renormalized to specific port 

impedance. 

3.2 Features of HFSS: 

3.2.1 Capabilities: 

• Accurate full-wave EM simulation 

• Import/export of 3D structures 

• Automatic adaptive mesh generation and refinement 

• Adaptive Lanczos-Padé Sweep for fast frequency sweeps 

• Inclusion of skin effect, losses 

• Direct and iterative matrix solvers 
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• Eigen mode matrix solver 

 

3.2.2 Solution Data (Visualization): 

• S-, Y-, Z-parameter matrix (2D plot, Smith Chart) 

• Port characteristic impedance 

• Current, E-field, H-field (3D static and animated field 

• plot in vector display or magnitude display) 

• Far-field calculation (2D, 3D, gain, radiation pattern) 

• Material losses, radiation losses. 

 

3.3 Ansoft terminology  

  The Ansoft HFSS window has several optional panels 

A. Project Manager 

B. Message Manager 

C. Property window 

D. Progress window 

E. 3D Modeler window 

 

These above managers and windows are shown in fig. and their details are given in 

coming sections 

 

 

 

 

 

 

 



 
18 

 

 

 

 

 

3.4 HFSS window 

 

 From Windows Start menu, open the Control Panel 

 Select System. 

 From the left pane, select Advanced system settings 

 Click Environment Variables 

 Under User variables, click New 

 Set the variable LM_LICENSE_FILE and click OK. 

 When the initial setup is complete, start the tool. 

 

 

Figure 3.1 Ansoft HFSS window 
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3.5 Project Mangers 

 

                                                      Figure 3.2: Ansoft project manager 
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3.5 Property window: 

 

 

                                     

                             Figure 3.3: Ansoft property window 
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3.6 Modeler window 

 

 

                                 

                        Figure 3.4 Ansoft HFSS window 

 

 

3.8 Toolbars: 

The toolbar buttons are shortcuts for frequently used commands. Toolbars are 

displayed in this illustration of the Ansoft HFSS initial screen, but your Ansoft HFSS 

window probably will not be arranged this way. 

 

 

                                             Figure 3.5 Toolbar 
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  3.9 Ansoft HFSS Desktop  

         Ansoft HFSS Desktop provides an intuitive, easy-to-use interface for developing RF 

device models. Creating designs, involves the following:  

A. Parametric Model Generation -creating the geometry, boundaries and excitations.  

B. Analysis Setup -defining solution setup and frequency sweeps.  

C.  Results -creating 2D reports and field plots.  

        D. Solve Loop -the solution process is fully automated. 

To understand how these process co-exist, determine the illustration shown here, 

 

                                Figure 3.6: Flow chart illustration of Ansoft HFSS 
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3.10 Opening an HFSS project 

This section describes how to open a new or existing project. First, go the HFSS software and 

click to open. Then go file and click Open file. And select desired file and open it. 

 

 

3.11 Opening a New project  

a. In an Ansoft HFSS window, select the menu item File. New. 

b. Select the menu Project. Insert HFSS Design.   

 

 

 

3.12 Opening an Existing HFSS project  

To open an existing project:  

a. In an Ansoft HFSS window, select the menu File > Open. Use, the Open dialog to 

select the project.  

b. Click Open to Open the Project. 
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3.13 Set Solution Type 

This section describes how to set the Solution Type. The Solution Type defines the type 

of results, how the excitations are defined and the convergence. The following Solution 

Types are available.  

 

I. Driven Modal – calculates the modal-based S-parameters. The S-matrix, solution 

will be expressed in terms of the incident and reflected power of waveguide 

modes.  

 

II. Driven Terminal: Calculates the terminal – based S- parameters of multi 

conductor transmission line ports. The S-matrix, solutions will be expressed in 

terms of terminal voltages and currents.  

 

III. Driven Transient : It employs a time-domain (“transient”) solver – Typical 

applications include, but are not limited to Simulations with pulsed excitations, 

such as ultra-wide band antennas, lighting strikes, electro – static discharge ; field 

visualization employing short-duration excitations; time-domain Reflectometry.  

 

IV. Engine mode: Calculate the Eigen modes or resopnances, of a structure. The 

Eigen model solver finds the resopnant frequencies of the structure and the fiels at 

those resonant frequencies.  

 

3.14 Convergence 

I. Driven Modal – Delta S for modal S-Parameters. This was the only convergence 

method available for Driven Solutions in previous versions.  

II. Eigen mode- Delta F  

II. Driven Terminal New – Delta S for the single –ended or differential nodal S-

Parameters.  
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3.15 To set the solution type  

 Select the menu item HFSS > Solution Type  

 

  3.16 Solution Type Window  

 Choose one of the following:  

 Driven Modal  

 Driven Terminal  

 Driven Transient  

 Eigen Mode 

 

 

 

       3.17 Getting Help  

If you have any questions while you are using Ansoft HFSS you can find answers in 

several ways:  

 

 3.18   Ansoft HFSS Online Help  

 Provides assistance while you are working.  

 To get help about a specific, active dialog box, click the Help button in the dialog box 

or press the F1 key.  

 Select the menu item Help > Contents to access to online help system.  

 Tooltips are available to provide information about the tools on the toolbars or dialog 

boxes. When you hold the pointer over a tool for a brief time, a tooltip appears to 

display the name of the tool.  
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 As you move the pointer over a tool or click a menu item, the Status Bar at the 

bottom of the Ansoft HFSS window provides a brief description of the function of the 

tool or menu item.  

 The Ansoft HFSS Getting Started guide provides detailed information about using 

HFSS to create and solve 3D EM projects.  

 

3.19 Ansoft Technical Support  

1. To contact Ansoft technical support staff in your geographical area, please log on 

to the Ansoft corporate website, ansoft.com and select Contact.  

 

2. Your Ansoft Sales engineer may also be contacted in order to obtain this 

information.  

 

3.20 Visiting the Ansoft Web Site  

If your computer is connected to the Internet, you can visit the Ansoft Web site to learn 

more about the Ansoft Company and products.  

 From the Ansoft Desktop Select the menu item Help > Ansoft Corporate Website to 

access the online technical support (OTS) system.  

 From your Internet browser Visit- www.ansoft.com 

Or visit www.youtube.com/ansoft.hfss 

 

 3.21 For Technical Support  

The following link will direct you to the Ansoft Support Page. The Ansoft Support Pages 

Provide additional documentation, training and application notes.  

 

 

 

 

 

http://www.ansoft.com/
http://www.youtube.com/ansoft.hfss
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Chapter 4 

Results and discussion 

 

In this chapter we will discuss about the effects of various shapes of a microtrip patch array 

antenna. We will also see that the bandwidth will be increased when we will used different types 

of patch array. 

 

 For design & simulation we used HFSS (High Frequency Structural Simulator).  

 

4.1 Design and simulation of microstrip patch array antenna: 

 

 

Figure 4.1Snapshot of the designed microstrip patch array antenna 

 

Here substrate height is h= 1.6mm. Substrate length = 85mm at Y axis and width = 158mm at X 

axis. Here in patch, we use ‘pec’ material and substrate material use many type. Which have a 

different relative permittivity (εᵣ) and that changes we get different result. Those result is show in 

simulated part. 
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The percentage bandwidth of the antenna is calculated using the formula- 

% Bandwidth = 
∫2−𝑓1

𝑓0
100%                    (4.1) 

Where f1 and f2 are the lower and upper cut off frequencies and f0 is the center frequency.  

 

4.2 Simulated results of a patch array antenna 

After simulating the return loss of the optimized antenna from HFSS is shown in Figure 4.2 at7.5 

GHz a return loss of -10 dB is achieved. 

Now after taking Rogers ultralam1300(tm) as a substrate material, whose relative permittivity r 

is 3. 

 

 

 

Figure 4.2: Return loss vs. frequency of an array antenna taking Rogers ultralam 1300(tm) as 

substrate. 

 

 

 

Here after using equation 4.1 we get percentage bandwidth is 21.94%. We get array antenna for 

use“Rogers ultrlam 1300(tm)” substrate. That’s substrate height 1.6 mm. Its relative permittivity 

is 3. 
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          Figure 4.3: 3D polar plot of an array antenna for Rogers ultralam 1300(tm) as a substrate 

 

 

          Figure 4.4 Return loss vs frequency of an array antenna for Rogers RT/duroid                                                                

6010/6010LM in HFSS. 
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From figure4.4, using equation (4.1) the calculated percentage bandwidth is 86.56%. The 

substrate thickness is 1.6 mm.  The relative permittivity of Rogers RT/duroid 6010/6010LM is 

10.2.  

 

 

 

             Figure 4.5 Radiation pattern for 2D for “Rogers RT/duroid 6010/6010LM(tm)” substrate   

 

 

             Figure 4.6 Radiation pattern for 3D for“Rogers RT/duroid 6010/6010LM(tm)” substrate   
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                                                                   Figure 4.7 Smith chart 

 

 Table 4.1: Data sheet of relative permittivity (r) of substrate material and percentage 

bandwidth 

Substrate Material  

 

Relative 

permittivity (r ) 

f2 (GHz) f1(GHz) f0 (GHz) Bandwidth 

(%) 

Rogers RTduroid 

6002(tm)  

 

2.94 17.27 13.41 16.22 23.83 

Rogers ultralam 

1300 

 

3 17.2402 13.7698 15.8348 21.91 

Rogers TMM 

3(tm) 

3.27   17.0660 13.973 14.9369 20.70 

Rogers TMM 

10(tm) 

 

 

 

9.2 18.9184       13.5706   17.2796  30.94 

Rogers RT/durioid 

6010/6010LM(tm) 

10.2 15.7588 6.3093 10.9159 86.56 
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4.3 Percentage bandwidth and permittivity 
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Figure 4.8 Dependence of percentage bandwidth on permittivity of substrate material 

 

 

According to graph we see when permittivity is high that time % of bandwidth is increase array 

antenna at Rogers RT/duroid 6010/6010LM (tm) substrate. Here we get the maximun % of 

bandwidth on material Roger RT/duroid 6010/6010LM(tm) (εr= 10.2) is 86.56%. 
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4.4 Percentage Bandwidth and Substrate thickness 

 

Table 4.2: Data sheet substrate thickness and percentage bandwidth 

Substrate Material  Thickness 

(mm)  

f2 (GHZ) f1(GHZ) f0(GHZ) Bandwidth 

(%) 

Rogers 

RT/durioid 

6010/6010LM(tm) 

 

0.5     Not 

acceptable 

Rogers 

RT/durioid 

6010/6010LM(tm) 

 

1    Not 

acceptable 

Rogers 

RT/durioid 

6010/6010LM(tm) 

 

1.6 15.7588 6.3093 10.9159 86.56 

Rogers 

RT/durioid 

6010/6010LM(tm) 

 

2 17.1231 121652 16.2643 30.48 

Rogers         

RT/durioid 

6010/6010LM(tm) 

2.6 15.7568 14.3163 15.0931 9.54 

Rogers 

RT/durioid 

6010/6010LM(tm) 

3.4 20.8138 19.8889 20.4416 4.52 
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                              Figure 4.9: Dependence on percentage bandwidth and substrate thickness 
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4.5 Effects of feed position on percentage bandwidth 

The effects of feed position on the percentage bandwidth of array antenna using Rogers 

RT/durioid 6010/6010LM(tm) as a substrate material is discussed in this section. Table 4.3 

shows the data sheet. 

 

Table 4.3: Percentage bandwidth and feed position of   Rogers RT/durioid 

6010/6010LM(tm)  

Material name Feed positon  Bandwidth (BW)% 

   Rogers RT/durioid 

6010/6010LM(tm) 

38,2,1.6 Not acceptable 

   Rogers RT/durioid 

6010/6010LM(tm) 

55,2,1.6 32.31 

   Rogers RT/durioid 

6010/6010LM(tm) 

60,2,1.6 Not acceptable 

   Rogers RT/durioid 

6010/6010LM(tm) 

66,2,1.6 55.34 

   Rogers RT/durioid 

6010/6010LM(tm) 

69,2,1.6 86.56 

   Rogers RT/durioid 

6010/6010LM(tm) 

72,2,1.6 16.57 

   Rogers RT/durioid 

6010/6010LM(tm) 

85,2,1.6 72.35 

   Rogers RT/durioid 

6010/6010LM(tm) 

92,2,1.6 3.36 
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Figure 4.10 Dependence of percentage bandwidth on feed position 

 

From figure 4.7, it is found that the percentage bandwidth is highly sensitive to the feed position.  
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Chapter 5 

                                                                     Conclusion  

 

In this thesis we have designed a 4 patch microstrip array antenna using HFSS. After simulation 

86.56 percentage bandwidth was found with substrate material Roger RT/duroid 

6010/6010LM(tm) (r= 10.2). 

We have investigated the effect of substrate height and it is found that the maximum percentage 

bandwidth is available at a substrate height of 1.6 mm.  
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